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Installation Guide

Installing Rational Asset Analyzer
This section contains the installation instructions for IBM® Rational® Asset
Analyzer.
This guide contains information concerning the procedures associated with the
installation and configuration of Rational Asset Analyzer. Included are sample
installation verification procedures to ensure that the database loads correctly and
instructions on how to set up the sample applications.
For PDF version, go to Rational Asset Analyzer 6.1 Installation Guide.

Installation introduction
This installation information provides instructions to install, update and uninstall
Rational Asset Analyzer.
You can find the most recent version of this guide online at http://www.ibm.com/
support/knowledgecenter/SS3JHP_6.1.0/com.ibm.raa.product.doc/
helpindex_raa.html.
Note: For product support, see http://www.ibm.com/support/entry/portal/
Overview/Software/Rational/Rational_Asset_Analyzer.

Installation conventions and terminology
Understanding these terms and conventions can help you take full advantage of
the installation information and your product.
The following conventions are used in this installation information:
v The default installation directory is written as C:\installation_directory\product\
inst.file.
v The default log location for installation information is C:\log_file_dir\log.txt.
These terms are used in the installation topics.
Installation directory
The location of product files after the package is installed.
Package
An installable unit of a software product. Software product packages are
separately installable units that can operate independently from other
packages of that software product.
Package group
A package group is a directory in which different product packages share
resources with other packages in the same group. When you install a
package using Installation Manager, you can create a new package group
or install the packages into an existing package group. (Some packages
cannot share a package group, in which case the option to use an existing
package group is unavailable.)

© Copyright IBM Corp. 2013, 2018
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Repository
A storage area where packages are available for download. A repository
can be disc media, a folder on a local hard disk, or a server or Web
location.
Shared directory
In some instances, product packages can share resources. These resources
are located in a directory that the packages share.

Planning the installation
Before you install or update the product, plan the installation. When you
effectively plan and understand the key aspects of the installation process, you can
ensure a successful installation.
You can install Rational Asset Analyzer from any of the following media:
v The product CDs
v A downloaded electronic image on your workstation
v An electronic image on a shared drive
v A repository on an HTTP or HTTPS server
In the latter three scenarios, you can choose to run IBM Installation Manager in
silent mode to install Rational Asset Analyzer.
You can install updates at the same time that you install the base product package.

Installation roadmap
The installation roadmap list the high-level steps for installing your product.
To install Rational Asset Analyzer:
1. Verify that your computer meets the minimum hardware and software
requirements for installing the product.
2. Verify that your user ID meets the requirements for installing the product.
3. Review the planning information.
4. Install or update IBM Installation Manager, if necessary.
5. Install the product.
v If using the Setup disk to start, see “Installing using the launchpad program”
on page 8.
v If using Installation Manager, see “Installing Installation Manager” on page 3.
v If upgrading from a previous version, see “Installing Rational Asset Analyzer
as an update” on page 13
6. Verify that the installation is successful.
7. Perform any necessary post-installation task such as migrating an existing
database and configuring the appropriate product license.

Installation Manager overview
You can use IBM Installation Manager to install, update, and modify IBM software
packages. You can also track what you installed, determine what is available to
install, and organize installation directories.
Installation Manager provides tools to update, modify packages, and uninstall
packages and to manage the licenses for your packages:
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v Install packages: Use the "Install" wizard to complete the installation process.
You can install a package by accepting the defaults or you can modify the
default settings to create a custom installation. Before you install the package,
you can review a complete summary of your selections throughout the wizard.
You can install one or more packages at one time.
v Update packages: Use the "Update" wizard to search for available updates to
packages that you have installed. An update might be a released fix, a new
feature, or a new version of the product. The wizard provides details of the
update. You can choose whether to apply an update.
v Modify packages: Use the "Modify" wizard to modify certain elements of a
package that you have installed. During the first installation of the package, you
select the features to install. Later, if you need other features, you can use the
modify packages wizard to add those features to your package. You can also
remove features and add or remove languages.
v Manage licenses: Use the "Manage Licenses" wizard to set up the licenses for
your packages. Use this wizard to change your trial license to a full license, set
up servers for floating licenses, and select the type of license for each package.
v Roll back to an earlier version: The "Roll Back" feature is included in
Installation Manager to revert to a previous version of a package.
Note: This feature is not supported for Rational Asset Analyzer.
v Uninstall packages: Use the "Uninstall" wizard to remove a package from your
computer. You can uninstall more than one package at a time.
For the most current information about Installation Manager, see
http://www.ibm.com/support/knowledgecenter/SSDV2W/welcome.

Installing Installation Manager
Use IBM Installation Manager to install your software packages. If you do not have
Installation Manager installed already it is automatically installed when you start
the installation for your product. You can download and install Installation
Manager before you start the installation process for Rational Asset Analyzer.

About this task
The latest version of Installation Manager might be required for your package.
Updates are discovered automatically if you have not cleared the Search service
repositories for updates check box on the Installation Manager preference page.

Starting Installation Manager
About this task
If you already installed Installation Manager, you can start it in one of these ways:
v Click Start > All Programs > IBM Installation Manager > IBM Installation
Manager
v From a command line, change to installation_manager_directory/eclipse and
run IBMIM.
If a new version of Installation Manager is found after starting Installation
Manager, you are prompted to confirm that you want to install it before you can
continue. Click OK to proceed. Installation Manager automatically installs the new
version, stops, restarts, and resumes.

Installing Rational Asset Analyzer
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Installation requirements
To install the product, you must meet several requirements, including requirements
for hardware, software, server environment and operating systems.

Hardware and software requirements
Before you install the product, verify that your hardware and software meet or
exceed the minimum requirements. If your hardware and software do not meet the
minimum requirements, you might not be able to install or run the product.
The machine on which you are installing Rational Asset Analyzer, must have a
supported version of DB2® and a supported application server. Rational Asset
Analyzer ships with DB2 and WebSphere® Application Server with licenses limited
to use with Rational Asset Analyzer on Windows. In addition, Rational Asset
Analyzer includes an embedded application server, implemented using the
WebSphere Application Server Liberty Profile, that can be used instead of the full
WebSphere Application Server.
For an up-to-date list of minimum requirements, see:
v System Requirements for Rational Asset Analyzer
v System Requirements for Rational Asset Analyzer for System z®

Requirements for installers
You must have a user ID that meets specific requirements before you can install
Rational Asset Analyzer.
Verify that your user ID meets these requirements before you begin to install your
product:
v Your user ID must not contain double-byte characters.
v Your user ID must have authorization to update the database manager
configuration and to create a database, tables, indexes, and views.
v You must log in to the Administrator account (or run as Administrator;
right-click the program file or shortcut and select Run as Administrator) and
have SYSADM authority to perform the following tasks. In addition, the user ID
you specify in the installation dialog must have DBADM authority to the RAA®
database.
– Install or update IBM Installation Manager
– Install or update a product offering
– Install an Authorized-User license key for your product by using IBM
Installation Manager
Important: To enable users who are not an Administrator to work with a
product on Windows:
– Do not install the product into a package group (installation location) in the
Program Files directory (C:\Program Files\) and do not choose a shared
resources directory in the Program Files directory.
– If you are extending an existing Eclipse installation, then do not install Eclipse
in the Program Files directory (C:\Program Files\).

Requirements for the embedded application server
If your Rational Asset Analyzer installation uses the embedded application server,
which is implemented by using the WebSphere Application Server Liberty Profile,
you need to adjust the maxConcurrentPageRequests value according to the number
of anticipated users.
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The maxConcurrentPageRequests property represents the maximum number of
requests for pages that can be rendered simultaneously. This value is used to
calculate the maximum allowable number of concurrent database connections. If
the value is lower than the actual number of concurrent page requests, some
requests might have to wait for an available database connection.
The default value for the maxConcurrentPageRequests property is 10.
To change the maxConcurrentPageRequests value, open the
installation_directory\config\Common.cfg file and edit the value.
If the maxConcurrentPageRequests value is changed after the embedded
application server is created, you must re-create the server. You can run
installation_directory\bin\server create to re-create the server.

Installation considerations
As you plan your installation, determine the details of the installation.
Consider the following details:
v Where to install the product
v How the product must work with other applications
v How to migrate from another version
v How to configure the help content

Installation directories
IBM Installation Manager uses two directories when installing product artifacts: the
shared resources directory and the package group.

Shared resources directory
The shared resources directory is where product resources are installed so that they
can be used by multiple product package groups. You define the shared resources
directory the first time that you install the first product package. For best results,
use your largest disk drive for shared resources directories. You cannot change the
directory location unless you uninstall all product packages.
Important: When installing products on the Windows operating system, do not
create the shared resources directory in the Program Files directory (C:\Program
Files\). Otherwise, users without Administrator privileges will be unable to use
the product.

Package groups
During installation, you specify a package group into which to install a product.
Rational Asset Analyzer is installed in its own package group. It does not share
package group with other packages.
v A package group represents a directory in which products share resources.
v When you install a product using the Installation Manager, you either create a
package group or install the product into an existing package group. A new
package group is assigned a name automatically; however, you choose the
installation directory for the package group.
v After you create a package group you cannot change the installation directory.
The installation directory contains files and resources shared by the products
installed into that package group.
Installing Rational Asset Analyzer
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v Product resources designed to be shared with other packages are installed in the
shared resources directory. Not all products can share a package group, in which
case the option to use an existing package group will be disabled.
v When you install multiple products at the same time, all products are installed
into the same package group.
Important: When installing products on the Windows operating system, do not
create package groups in the Program Files directory (C:\Program Files\).
Otherwise, users without Administrator privileges will be unable to use the
product.

Upgrade information
The process to upgrade Rational Asset Analyzer depends on your current version.
v If you have a version of Rational Asset Analyzer earlier than Version 6.0.0.1, you
cannot use the update feature to upgrade. You will need to uninstall your
current version and then install the new version.
v If you are updating from Version 6.0.0.1 or later, you can use the Installation
Manager update feature.
If you have installed any of Rational Asset Analyzer product components, you
need to uninstall them before installing Rational Asset Analyzer on your Windows
system.
If you have an existing database, you can do one of the following with the
database:
v To preserve the data in the database, you must migrate it to the current schema
level using the Migration Utility. Download the utility from the following web
site: http://www.ibm.com/support/fixcentral/.
v To not preserve the data in the database, manually drop the database before
starting the installation process.
Note: Work request objects in the work queue may not be compatible between
modification levels. For example, Impact Analysis work requests in the work queue
may be discarded when a program temporary fix (PTF) is applied. Before stopping
the Rational Asset Analyzer web applications to apply a PTF, therefore, you should
ensure that all important work items in the work queue have been completed.
Make sure work items shown in the queue are no longer in the queued or running
state. If you do not care whether certain work items complete, you can either
cancel them or leave them in the queued state. Canceling them will ensure that
they will not be reloaded when the web applications restart. If you leave them in
the queued state, they may or may not reload when the web applications restart
(depending on what code changes have occurred in the applied PTF).

Performing silent installations
Read the silent installation documentation on the IBM Installation Manager
Knowledge Center for information on installing the product silently on one or
more machines.
The Installation Manager product documentation contains instructions for
installing the product silently on one or more machines. The product
documentation is located at the following web site: http://www.ibm.com/
support/knowledgecenter/SSDV2W/welcome.
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Preinstallation tasks
To prepare for and simplify the installation process, back up files, prepare
databases and servers where required, and configure workstations.

Preinstallation checklist
Before you install Rational Asset Analyzer, ensure that the preinstallation steps are
completed as required.

Procedure
__ 1. If you are installing from an electronic image that was downloaded, verify
that you have the required parts and have extracted the download files
correctly.
__ 2. Ensure that you are logged on to your computer with an appropriate user
ID.
__ 3. Back up any necessary files.

Backing up files
Files that you create and maintain represent a considerable investment. Although
the installation process is not designed to write over or delete files that you create,
protect your investment by backing up these files. During installation the following
directories and files are used: install_directory\scan\DmhScan.cfg,
install_directory\config and install_directory\data. You should create a
backup copy of these directories and files in case an error occurs and the backup
copies created during the installation process are corrupted.

Verifying and extracting electronic images
If you download the installation files from IBM Fix Central, before you install the
software, verify the completeness of the downloaded files and extract the electronic
image from the files. If you select the Download Director option for downloading
the installation files, the Download Director applet automatically verifies the
completeness of each file that it processes.

About this task
To extract the installation files from the downloaded compressed file, follow these
steps:

Procedure
1. Preserve the directory structure of the downloaded compressed files
2. Extract the contents of all the compressed files to the same directory

Installing Rational Asset Analyzer
To install Rational Asset Analyzer, follow the procedures in this section. Before you
start the installation process, be sure to complete the planning and preinstallation
tasks first.

About this task
There are two ways to start the installation process. You can start the process using
the installation launchpad or IBM Installation Manager.
v “Installing using the launchpad program” on page 8
Installing Rational Asset Analyzer
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v “Installing using Installation Manager”
If you are upgrading from an earlier release of Rational Asset Analyzer Version
6.0.0.1 or later, you can use the steps in the “Installing Rational Asset Analyzer as
an update” on page 13 topic.

Installing using the launchpad program
You can start the installation process from the launchpad program. The Setup disk
image includes the launchpad program, which provides you with a location to
start the installation process.

About this task
When you start the installation process from the launchpad program, IBM
Installation Manager is automatically installed if it is not already on your
computer. When the installation process starts, Installation Manager is already
configured with the location of the repository that contains the installation
package. If you install and start Installation Manager directly, then you must set
repository preferences manually.
Important: Installation notes for the Windows operating system:
v If you plan to start the installation from the launchpad program, run the
launchpad program as administrator. If the launchpad program starts
automatically, stop the launchpad program, and restart it by using the Run as
administrator option at the root level of the disk image. Right-click the
launchpad.exe file, and click Run as Administrator.
v Do not select installation directories within the Program Files directory
(C:\Program Files). If you select either an installation location or shared
resources directory within the Program Files directory, only an administrator can
run the installed packages.

Procedure
1. Open a command line and change to the directory in which you extracted the
disk images. Run launchpad.exe.
2. When you are ready to begin the installation, click Install Rational Asset
Analyzer > Launch Rational Asset Analyzer.
3. If IBM Installation Manager is not detected on your system or if an
incompatible version is already installed, then you must continue with the
installation of the latest release.
a. Follow the instructions in the wizard to complete the installation of the
Installation Manager.
b. When the installation completes successfully, click Finish to close the
wizard. After the installation is complete, Installation Manager opens
automatically.
4. Complete the installation by following the steps in “Installing using Installation
Manager.”

Installing using Installation Manager
Install Rational Asset Analyzer by using IBM Installation Manager.
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Before you begin
IBM Installation Manager must be running. Your computer must be connected to
the repository location containing the Rational Asset Analyzer product image.

Procedure
1. Start Installation Manager.
Note: If a new version of Installation Manager is found, you are prompted to
confirm that you want to install it before you can continue. Click OK to
proceed. Installation Manager automatically installs the new version, stops,
restarts, and resumes.
2. Specify the repository that contains the product package.
a. On the Start page of Installation Manager, click File > Preferences, and
then click Repositories. The "Repositories" page opens, showing any
available repositories, their locations, and whether they are accessible.
b. On the "Repositories" page, click Add Repository.
c. On the "Add repository"page, type the URL of the repository location or
browse to it and set a file path.
d. Click OK. If you provided an HTTPS or restricted FTP repository location,
then you will be prompted to enter a user ID and password. The new or
changed repository location is listed. If the repository is not accessible, a
red x is displayed in the Accessible column.
e. Click OK to close the "Preferences" page.
3. On the Installation Manager start page, click Install. If you have started the
install process from the launchpad, this step is omitted.
4. The "Install" page of the Install Packages wizard lists the packages in the
repositories identified on the Installation Manager "Preferences" page. The
most recent version of the package is displayed. If you have started the install
process from the launchpad, this step is omitted.
5. Select the Rational Asset Analyzer package that you want to install. If you
have not done so already, read the release information by clicking More info
> Release information. Click Next to continue.
6. On the "Licenses" page, read the license agreement for the selected package. If
you agree to the terms of all of the license agreements, click I accept the terms
of the license agreements. Click Next to continue.
7. On the "Location" page, type the path for the shared resources directory in the
Shared Resources Directory field, or accept the default path. The shared
resources directory contains resources that can be shared by one or more
package groups. Click Next to continue.
The default path for Windows is C:\Program Files\IBM\IBMIMSShared.
Important: You can only specify the shared resources directory when you
install the first package. Use your largest disk for this to ensure adequate
space for the shared resources of future packages. You cannot change the
directory location unless you uninstall all packages.
8. On the "Location" page, create a package group to install the product package
into. If you are updating the package, use the existing package group. To
create a new package group:
a. Click Create a new package group.
b. Type the path for the installation directory for the package group. The
name for the package group is created automatically.
Installing Rational Asset Analyzer
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The default path is: C:\Program Files\IBM\Rational Asset Analyzer
Important: On Windows, the Program Files directory is virtualized so that
users who are not running as the administrator have write access to this
protected directory. However, the virtualization workaround is not
compatible with the product.
If you want to enable users who do not have Administrator privileges to
run the product, do not select an installation location or Shared Resources
directory in the default path C:\Program Files\IBM\. Instead, select a
directory in a different path, such as C:\Program Files_IBM\.
c. Click Next to continue.
9. On the Features page, Rational Asset Analyzer is preselected as the feature to
install. The lower half of the panel provides details and disk space
information. Click Next to continue.
10. A navigation tree on the left lists the required components that must be
configured for the installation. A white X in a red circle appears next to the
components that do not have required information entered; a white check
mark in a green square appears next to components that have all required
information entered. The Installation Manager will pre-populate the fields
with available configuration information. To enter or change required
information, click the appropriate components in the navigation list on the left
side of the window.
v Database Properties
DB2 Home or DB2 Connect™ Home
The location where DB2 is installed on your system.
TCP/IP port
The port number of the DB2 instance. The default value is 50000 on
Windows and AIX®.
Database name
The name used for Rational Asset Analyzer inventory database. The
default is DMHDB.
Table schema name
The high-level qualifier for the tables. The default is DMH.
Username
The user ID of a database administrator who has the proper DB2
authority (DBADM) for creating database objects like tables,
indexes, views, and triggers.
When a new database is created on Windows, and the username of
the person performing the installation is different from the database
username specified in the installation panel, the database username
is granted DBADM authority on the new database.
Password
The database password for the user ID specified above. This value
is encoded when the Rational Asset Analyzer enterprise application
is started and the values are read from the configuration file.
Users with administrator privileges
List of user IDs with the authority to perform administrative
functions in Rational Asset Analyzer, such as deleting definitions.
The default value of * allows all users to access these functions. To
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restrict administrator authority, list user IDs to be granted
administrator access, separated by commas.
To validate your DB2 settings, enter the username and password and click
Validate Settings. When your settings are validated, the Validate Settings
button will become disabled and the Next button becomes enabled.
If you receive a warning message that the database already exists, this is
not a problem unless you are refreshing your Rational Asset Analyzer with
a later version and you have not been instructed that the later version
requires that the database be dropped and recreated.
v Hostname
The host name or IP address of the machine on which you are currently
installing Rational Asset Analyzer. If you use localhost for the value, your
Rational Asset Analyzer system will not be accessible from other systems. It
will only be accessible from your local system.
v Site Information
The site name and description that identify the system on which you are
installing Rational Asset Analyzer in the inventory database and user
interface.
v Application Server
To change your application server information, select from the following
options:
Use the embedded application server
Select this option to indicate that your Rational Asset Analyzer
installation use the embedded application server, which is
implemented using the WebSphere Application Server Liberty
Profile. This option is available only when installing on Windows.
When selected, the following settings apply:
Port

The port number through which deployed enterprise
applications are accessible by a browser It can be any
available port number, for example, 9080.

Protocol
The protocol through which deployed web applications are
accessible through a browser. If https is chosen, SSL is used
to ensure secure communications.
Note: When Rational Asset Analyzer is installed using the
embedded application server, there is no corresponding Windows
service installed for the embedded application server. As a result,
the embedded application server shuts down when the user who
started the embedded application server logs off of the server
system. To avoid this, you can use the Task Scheduler in Windows
to start the embedded application server and keep it running even
when no user is logged on to Windows. For more information, see
“Starting the embedded application server using the Task
Scheduler” on page 15.
Use WebSphere Application Server (best for enterprise installations)
Select this option to indicate that yourRational Asset Analyzer
installation use WebSphere Application Server. This option displays
only when installing on Windows. When installing on AIX, this
option assumed. When selected, or in the case of AIX, when
assumed, the following settings apply.

Installing Rational Asset Analyzer
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Note: The WebSphere Application Server information is not
populated automatically. Click Retrieve server information for the
Installation Manager program to detect your server settings
automatically. After the settings are detected, the remaining fields
are populated with the appropriate information. Verify that the
correct server was detected. Click Test Connection to validate the
settings before proceeding with the installation.
Application server home directory
Type the name of the directory in which WebSphere
Application Server is installed or click Browse to select a
new home directory. The home directory can be the
was_installation_directory\AppServer directory, or the
directory of a server profile, for example,
was_installation_directory\AppServer\profiles\
<profileName>. The directory must include the
\bin\wsadmin.bat file.
Global security settings
If a username and password are required to access
WebSphere Application Server, enter them in the Username
and Password fields.
Cell name
The name of the cell containing the node containing the
application server that will host the web applications.
Node name
The name of the node containing the application server that
will host the web applications. The name can be determined
by looking at the WebSphere Application Server
Administrative Console under Server > Application servers
> servername > Node.
Server name
The name of the application server that will host the web
applications. The name can be determined by looking at the
WAS Administrative Console under Server > Application
servers.
Web container port
The port number through which deployed web applications
are accessible by a browser. The value can be determined by
looking at the Websphere Application Server Administrative
Console under Server > Server types > Websphere
Application Servers > servername > Ports.
Web container protocol
The protocol through which deployed web applications are
accessible through a browser. This is typically http or https.
v Scanning Framework
The port to be used by the scanner daemon. Click Next to accept the
default value of 8088, or specify the value of an available port.
v Java Home Location (AIX-only)
The Installation Manager attempts to detect the location of the Java™ home
directory. If you want to use a different installation of these products, you
can change the home directory for Java by clicking Browse and selecting
another directory from the directory selection window.
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v Log and Temp directories
If you want to change the default location of the Rational Asset Analyzer
log and temp files, type new directories on this page, or click Browse and
select another directory from the directory selection window.
Click Next to continue.
11. On the Summary page, review your choices before installing the product
package. If you want to change choices that you made on previous pages,
click Back and make your changes. When you are satisfied with your
installation choices, click Install to install the package. A progress indicator
shows the percentage of the installation that is completed.
12. When the installation process is complete, a message confirms the success of
the process. Check the log file for errors.
a. To open the installation log file, click View log file. The log file will open
in a new window. You must close the Installation Log window to continue.
b. Click Finish to close Installation Manager.
13. If you are using WebSphere Application Server, restart it before launching
Rational Asset Analyzer.

Installing Rational Asset Analyzer as an update
Install Rational Asset Analyzer by using IBM Installation Manager.

Procedure
1. Start Installation Manager.
Note: If a new version of Installation Manager is found, you are prompted to
confirm that you want to install it before you can continue. Click OK to
proceed. Installation Manager automatically installs the new version, stops,
restarts, and resumes.
2. Specify the repository that contains the product package.
a. On the Start page of Installation Manager, click File > Preferences, and
then click Repositories. The "Repositories" page opens, showing any
available repositories, their locations, and whether they are accessible.
b. On the "Repositories" page, click Add Repository.
c. On the "Add repository"page, type the URL of the repository location or
browse to it and set a file path.
d. Click OK. If you provided an HTTPS or restricted FTP repository location,
then you will be prompted to enter a user ID and password. The new or
changed repository location is listed. If the repository is not accessible, a
red x is displayed in the Accessible column.
e. Click OK to close the "Preferences" window.
3. On the start page of Installation Manager, click Update.
4. In the Update packages wizard, select the package group name containing the
installation location for Rational Asset Analyzer and click Next. A search is
performed for updates in the Rational Asset Analyzer repository on the Web
and in all of the repository locations that you specified. The search progress is
displayed.
5. On the "Update Package" page, the updates are displayed and selected. Select
the version of Rational Asset Analyzer that you want to install, then click
Next.

Installing Rational Asset Analyzer

13

6. On the "Licenses" page, read the license agreement for the selected package. If
you agree to the terms of all of the license agreements, click I accept the terms
of the license agreements. Click Next to continue.
7. Click Next on the "Features" page.
8. Review the summary information and click Update. A progress indicator
shows the percentage of the installation that is completed.
9. When the update process is complete, a message confirms the success of the
process. Check the log file for errors.
a. To open the installation log file, click View log file. The log file will open
in a new window. You must close the Installation Log window to continue.
b. Click Finish to close Installation Manager.
10. If you are using WebSphere Application Server, restart it before launching
Rational Asset Analyzer.

Post-installation tasks
After you have installed your product, complete the installation verification tasks
listed in the checklist.

About this task
If during the process, you encounter any error, refer to the “Known problems” on
page 27 for possible solutions.

Post-installation checklist
After you have installed your product, complete several tasks to configure and
verify the installation.

Procedure
__ 1. Verify that you can start Rational Asset Analyzer. For details see “Starting
Rational Asset Analyzer.”
__ 2. Learn how to start and stop the application server. For more information,
see “Starting and stopping the application server” on page 15.
__ 3. Verify that several key functions are working. For details see “Verify the
product usage” on page 17.
__ 4. Configure your product license. For more information, see “Manage
licenses” on page 21.
__ 5. Import product-suppled queries. See “Import product-supplied custom
queries” on page 20.
__ 6. Migrate your existing data base scheme to the new level using the Rational
Asset Analyzer Migration Utility if you want to continue using your existing
data base. See “Migrating database data” on page 21 for more information.
__ 7. Update the data base User ID and password. See “Updating the database
user ID and password” on page 21

Starting Rational Asset Analyzer
You can start your product from the desktop environment or a command-line
interface.
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About this task
For Microsoft Windows operating systems: Click Start > Programs > IBM >
Rational Asset Analyzer.
When prompted for a user name and password, make sure you enter a name that
was identified as having administrative privileges on the DB2 database information
page of the installation wizard.

Starting and stopping the application server
The method of starting and stopping the application server depends on which
application server is used.

About this task
Rational Asset Analyzer supports two types of application servers -- the embedded
application server and WebSphere Application Server. The embedded application
server is only available in certain operating environments, and is chosen during
installation.

Starting and stopping the embedded application server using
shortcuts
Procedure
To start and stop the embedded application server using shortcuts:
1. Click Start > All Programs > IBM Rational Asset Analyzer.
2. Click Start the server or Stop the server, as appropriate. The shortcuts must be
run as administrator.

Starting and stopping the embedded application server using a
command prompt
Procedure
To start and stop and otherwise administer the embedded application server from
a command prompt window that was started as administrator, run the following
commands:
1. To start the server: installation_directory\bin\server.bat start
2. To stop the server: installation_directory\bin\server.bat stop
3. To restart the server: installation_directory\bin\server.bat restart
4. To check the status of the server: installation_directory\bin\server.bat
status

Starting the embedded application server using the Task
Scheduler
Procedure
When Rational Asset Analyzer is installed using the embedded application server,
there is no corresponding Windows service installed for the embedded application
server. As a result, the embedded application server shuts down every time a
Rational Asset Analyzer user logs out of the operating system session on the server
system. To avoid this, you can use the Task Scheduler in Windows to start the
embedded application server and keep it running even when no user is logged on
to Windows.
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1. Click Start and enter Task Scheduler in the search box to find and start the
Task Scheduler.
2. In the Task Scheduler, click Action > Create task.
3. On the General tab:
a. For Name, provide a task name (for example, Start RAA Server).
b. Under Security options, select Run whether user is logged on or not and
select Run with highest privileges.
4. On the Triggers tab:
a. Click New.
b. In the Begin the task drop down, select At startup.
c. Click OK to save the trigger changes.
5. On the Actions tab:
a. Click New.
b. In the New Action dialog, click Browse and browse to and select the
<installDir>\bin\server.bat file (for example, C:\Program
Files\IBM\Rational Asset Analyzer\bin\server.bat).
c. In the Add arguments field, enter: start
d. Click OK to save the action changes.
e. Click OK to save the task.
6. When prompted, enter the User name and Password information for the user
account that will run this task.

Starting and stopping WebSphere Application Server using
shortcuts
Procedure
To start and stop the WebSphere Application Server on Windows using shortcuts:
1. Click Start > IBM WebSpere Application Server > Application Server >
Profiles > profile.
2. Click Start the server or Stop the server, as appropriate.

Starting and stopping WebSphere Application Server using a
command prompt
Procedure
To start and stop the WebSphere Application Server on Windows from a command
prompt, run the following commands:
1. To start the server: wasAppServerDir\bin\startServer.bat serverName
2. To stop the server: wasAppServerDir\bin\stopServer.bat serverName

Starting and stopping enterprise applications using the
WebSphere Application Server administrative console
Procedure
To start and stop enterprise applications using the WebSphere Application Server
administrative console on Windows, perform the following steps. The applications
should be started in the following order because of dependencies:
v wsaahelp
v com.ibm.dmh.rest
v wsaa
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1. Click Start > All Programs > IBM WebSphere Application Server >
Application Server > Profiles > profile > Administrative console.
2. In the left pane, click Applications > Application types > WebSphere
enterprise applications.
3. Choose the application and click Start or Stop, as appropriate.

WebSphere Application Server on z/OS
Procedure
For WebSphere Application Server on z/OS®:
See the WebSphere Application Server for z/OS documentation for the related
commands.

Verify the product usage
After the installation process is complete and there are no errors, start Rational
Asset Analyzer and verify several key functions.
v “Verifying the web interface”
v “Verify distributed asset inventory”
v “Verify CICS regions” on page 20
v “Verify z/OS asset inventory” on page 19

Verifying the web interface
After you start Rational Asset Analyzer, verify that the web interface is working
properly.

Procedure
1. Start Rational Asset Analyzer if it is not already started. Enter your user ID and
password and click OK to continue.
2. After the Rational Asset Analyzer Home page opens. Verify that there is a
timestamp, such as Wednesday, August 13, 2003 5:30:28 PM PDT, in the bottom
right corner of the window. If there is no timestamp, Rational Asset Analyzer is
not accessing the database properly and other Rational Asset Analyzer
operations will fail. The most likely cause of this problem is with JDBC.
To determine the cause of the problem, check the logs that were produced
when you started the embedded application server or WebSphere Application
Server and the HTTP Server. Look for DB2 connection errors in the log files,
such as messages indicating that JDBC is not configured properly, or is
otherwise not communicating properly with DB2. Correct any errors before
proceeding.

Verify distributed asset inventory
Verify that the inventory for distributed assets data is working.

Procedure
Complete the following steps to start the distributed scanner and collect asset
inventory to validate.
1. Click Database > Collect inventory.
2. In the "Choose an inventory activity" panel, select Windows File System scan
option. Click Next.
3. In the "Choose a site" panel, select a site from the drop-down list or click New
to create a site. Click Next.
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4. In the "Specify the container" panel, complete the following:
a. In the Windows Directory field, type installation_directory\sample\
j2ee.
b. Select Scan specified directory and all subdirectories.
c. Select Scan inside zip files and click Next.
5. In the "COBOL scanning options" panel, take the default setting and click
Next.
6. In the "PL/I scanning options" panel, take the default setting and click Next.
7. In the "Assign to application" panel, select Assign to a new application from
the drop-down list and enter the name of the new application, for example
RAAIVP. Click Next. If you use the same application name for distributed and
z/OS assets, both sets of assets can be viewed under the same application in
the "Application details" view.
8. In the "Assign default concatenation sets" panel, ensure that all the drop-down
options are set to none and click Next.
9. In the "Add to the queue" panel, review the information for your scan request,
and click Next.
10. In the "Process queued requests" panel, click Finish for the scan to run.
11. View your inventory collection progress using the Database > Analysis queue
menu option. Refresh the page periodically to see the postprocessing progress.

Results
After performing inventory collection for the IVP data for distributed assets,
validate that you have the correct content by clicking Explore > Distributed assets.
Compare the content displayed in your window to the contents in Table 1.
Generally, it is okay if the numbers are slightly different because of the nature of
the tool and the fact that it is changing. However, it is not okay if you do not see
basically the content that appears below.
If you do not see this information, go to the “Known problems” on page 27 section
to review possible solutions.
Table 1. Sample distributed asset data
Containers
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Total Java

Total Web
41 EJB

Total Other

Enterprise
application

2 Java package

Web application

2 Java bytecode
class

EJB-JAR

2 Java bytecode
method

6563 JSP file

12

J2EE client

0 Java bytecode
field

3157 XML file

35

Connector
archive

0

Servlet

3

JAR file

3

JSP tag

226

Java bytecode
root

2

JSP tag library

730 HTML file

11 Archive manifest
file
4 C++

12

Tag library
validator

0

Servlet event
listener

0

Filter

0

Total
10
0

Verify z/OS asset inventory
Verify that the z/OS asset inventory data collection is working.

Procedure
Complete the following steps to collect z/OS asset inventory to validate.
1. Click Database > Collect inventory.
2. In the "Choose an inventory activity" panel, select Windows File System scan
option. Click Next.
3. In the "Choose a site" panel, select a site from the drop-down list or click New
to create a site. Click Next.
4. In the "Specify the container" panel, complete the following:
a. In the Windows Directory field, type installation_directory\sample\
source.
b. Select Scan specified directory and all subdirectories.
c. Select Scan inside zip files and click Next.
5. In the "COBOL scanning options" panel, take the default setting and click
Next.
6. In the "PL/I scanning options" panel, take the default setting and click Next.
7. In the "Assign to application" panel, select Assign to a new application from
the drop-down list and enter the name of the new application, for example
RAAIVP. Click Next. If you use the same application name for distributed and
z/OS assets, both sets of assets can be viewed under the same application in
the "Application details" view.
8. In the "Assign default concatenation sets" panel, ensure that all the drop-down
options are set to none and click Next.
9. In the "Add to the queue" panel, review the information for your scan request,
and click Next.
10. In the "Process queued requests" panel, click Finish for the scan to run.
11. View your inventory collection progress using the Database > Analysis queue
menu option. Refresh the page periodically to see the postprocessing progress.
Following successful inventory collection, five entries will remain in the
Analysis queue, Step name "Establish PSB for run unit". This is by design and
can be ignored for the purposes of install verification.

Results
After performing inventory collection for the IVP data for z/OS assets, validate
that you have the correct content by clicking Explore > z/OS assets. Compare the
content displayed in your window to the contents in Table 2. Generally, it is okay if
the numbers are slightly different because of the nature of the tool and the fact that
it is changing. However, it is not okay if you do not see basically the content that
appears below.
If you do not see this information, go to the “Known problems” on page 27 section
to review possible solutions.
Table 2. Sample z/OS asset data
Run time
Batch job

Total Program
29 BMS map definition

Total Data
1 Data element

CICS® group

2 BMS map set definition

1 Data set

CICS online region

1 Concatenation set

1 Data store
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Total
2958
140
70
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Table 2. Sample z/OS asset data (continued)
Run time

Total Program

CICS transaction

4 DB2 stored procedure

DB2 system

2 Entry point

IMS™ DBD

0 IBM PSB

IMS subsystem

0 Program

IMS transaction

0

Run unit

Total Data

Total

0 DB2 column

9

25 DB2 table

2

0 DD name

899

16 I/O record description

126

36

Verify CICS regions
To help you verify that Rational Asset Analyzer recognizes CICS regions and
includes associated transactions in the database inventory, Rational Asset Analyzer
provides a logical CICS region.

About this task
Use the "Collect inventory" wizard to load the logical CICS region into the
database.

Procedure
1. Edit the DMHREG01 file which is located in the installation_directory\sample\
imports\ directory.
2. Update the SITE record and replace SYSWAS4 with the name of the site that
was used for scanning the sample source (for example, MYSITE) and save your
changes.
FMT REGION 1
TOOL 0001000011
SITE MYSITE "z/OS"
START REGION ATC3
...

3. Save your changes.
4. Click Database > Collect inventory.
5. In the "Choose an inventory activity" panel, select Queue local import files for
loading. Click Next.
6. In the "Queue local import files" panel, click Browse, choose the file
installation_directory\sample\imports\DMHREG01, and click Open. Click Next.
7. In the"Process queued requests" panel, click Finish for the scan to run.
8. View your inventory collection progress using the Database > Analysis queue
menu option. Refresh the page periodically to see the postprocessing progress.
Following successful inventory collection, five entries will remain in the
Analysis queue, Step name "Establish PSB for run unit". This is by design and
can be ignored for the purposes of install verification.

Results
Click Explore > z/OS assets to view the scan results. You should see counts for the
CICS assets.

Import product-supplied custom queries
A set of customer queries are included when you install Rational Asset Analyzer.
You can optionally import these product-supplied custom queries into your
environment.
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About this task
To import, complete the following steps:

Procedure
1. Click Explore > Custom queries
2. From the Custom queries panel, click Import custom queries from the Actions
list to open the Custom query import wizard.
3. Select URL which contains the location of the product-supplied custom queries.
Enter the user ID and password if required and click Next to continue.
4. Select one or more custom queries to import and click Finish.

Migrating database data
If you have an existing databases, you can optionally migrate your data to use
with the new version of Rational Asset Analyzer. If you choose not to migrate an
existing database, you will need to define a new database to use with the product.

About this task
To preserve the data in an existing database, you must migrate it to the current
schema level using the Migration Utility. Download the utility from
http://www.ibm.com/support/fixcentral/.
The Migration Utility is a Java-based tool for automatically migrating the Rational
Asset Analyzer database to a newer schema level.
Note: Always download the current version of the migration utility before using it
to ensure that you are using the latest version.

Updating the database user ID and password
If the database user ID or password are changed after the product has been
installed, you must update the Common.cfg file manually by doing the following:

Procedure
1. Find the Common.cfg file located in installation_directory/config,
2. Locate the section containing information used to access the database.
3. Update the values for username and password by replacing the values right of
the equal sign with the new values.
[Database]
username=user_name
password=password

4. Save the changes.
5. If you are using the embedded application server, run the command
installation_directory\bin\server restart. Otherwise, from the WebSphere
Application Server administrative console, restart the Rational Asset Analyzer
enterprise applications.

Manage licenses
Licenses for Rational Asset Analyzer are managed using IBM Rational Common
Licensing. IBM Rational Common Licensing uses a license manager to monitor
license access and usage. The license manager runs on a license server.
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After installing Rational Asset Analyzer, you must import the entitled licenses into
a license server. A license server can be shared with other products, you do not
need a separate license server for Rational Asset Analyzer. To prevent lost of
product usage, import licenses before the built-in trial license expires.
Note: You cannot use Installation Manager to manage licenses for Rational Asset
Analyzer.
There are a number of sources for more information on managing licenses for your
Rational product.
v For additional information about IBM Rational Common Licensing and the
license server, see http://www.ibm.com/support/knowledgecenter/
SSSTWP_8.1.4/com.ibm.rational.license.doc/topics/c_managing_lic.html.
v For information about dealing with Rational product activation, see the technote
at http://www.ibm.com/support/docview.wss?uid=swg21250404 .
v For more information on managing licenses for your Rational product, see the
Rational licensing support page at http://www.ibm.com/software/rational/
support/licensing/.

Accessing license keys
The Rational License Key Center is an online licensing tool that allows you to
generate and return IBM Rational product license keys. Licenses entitlements are
established as part of purchasing the Rational product from IBM. You must be a
member of the IBM Rational License Key Center account for your company to
access license keys. The person placing the order is setup as the account
administrator and is sent a Welcome e-mail containing a temporary password for
logging into the Rational License Key Center.

About this task
The license administrator can request license keys in Rational License Key Center.
To purchase licenses and enable your product, complete the following steps:

Procedure
1. Access the License Key Center at: https://licensing.subscribenet.com/control/
ibmr/login and click Continue.
2. Log in to the IBM Rational License Key Center using the license administrator
e-mail address and License Key Center password. If you do not have an ID,
you will need to complete the New Customer information by clicking Don’t
have a password. The information needed to complete the form is located in
the IBM Proof of Entitlement (PoE) certificate, received by the person who
ordered the product.
3. Click Get keys from the action list on the left and then select IBM Rational
Asset Analyzer. You will be presented with instructions for completing the
registration process. The License Key Center provides links to instructional
videos and a getting started guide to help you download and install your
license keys

License types and order used
There are two types of licenses available that allow for handling of frequent and
occasional users: authorized user and floating licenses.
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Authorized User licenses permits a single, specific individual to use the product on
the client specified by the license. The Authorized User license does not entitle a
second person to use the product at any time, even if the licensed individual is not
actively using it. However, the license account administrator can replace the
original assignee on a long-term or permanent basis.
Floating licenses are for a single software product that can be shared among
multiple team members. However, the total number of concurrent users cannot
exceed the number of entitled floating licenses. For example, if there is one floating
license any user in your organization may use the product at any given time.
Another person who wants to access the product must wait until the current user
logs off. The license server responds to end-user requests for access to the license
keys and will grant access to the number of concurrent users that matches the
number of licenses the organization is entitled.
To use authorized or floating licenses, the license keys must be installed on a
Rational License Server. The Rational License Server does not serve a specific type
of license to a user when a user requests use of the product. It simply returns the
next available license for the requesting product. The type of license returned to a
requestor depends on the sequence of the licenses found in the license key file. The
license key file is created based on the data that is provided in IBM Rational
License Key Center. The license key definition contains information about the
server nodes and vendor daemons. The license key definition also contains at least
one line of data for each licensed product.

Combining license types
If there is a combination of authorized user and floating entitlements, the Rational
License Key Center creates the file with floating licenses first and the authorized
user licenses second. To ensure optimal order for authorizing access for both the
frequent and occasional user, the license key file must be changed so that
authorized user licenses are served first and floating licenses are served second.

About this task
The following procedure highlights the changes you can make to ensure that an
authorize user license is served to the assigned user.

Procedure
1. After generating your license keys, a license key file separate INCREMENT
statements are generated for floating and authorized user licenses. The
INCREMENT statement for floating licenses appears before the INCREMENT
statement for authorized user licenses regardless of the order in which your
request for the entitlement were made. Also, both the authorized user and
floating licenses are identified as a floating type license.
2. To change the order of the INCREMENT lines so that authorized user licenses
are served first, cut and paste the lines in a text editor before the floating
license INCREMENT statement. Save the file.
3. Import the text file into the license server.
4. On the "Edit Options File" window, click Yes to edit the options file. The
options file is used to define authorized users. You can also limit the number of
licenses each user or group can access. This file is used by the license server to
determine if the key request can be served by using an authorized key or
floating key.
5. Click Settings > Client/Server Configuration > Show Licenses to see the
licenses on the server. Select the appropriate server and click OK.
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Modifying software
With the Modify Packages wizard in IBM Installation Manager, you can change the
language and feature selections of an installed product package. You can also use
the Modify Packages wizard to install new features that might be included in a
package update, such as a refresh pack.

Before you begin
By default, Internet access is required unless the repository preferences points to a
local update site. See the Installation Manager help for more information.
Note: Close all programs that were installed using Installation Manager before
modifying.

About this task
To modify an installed product package:

Procedure
1. From the Start page of the Installation Manager, click the Modify icon.
2. In the Modify wizard, select the installation location for the product, and click
Next.
3. On the Modify page, under Languages, select the languages for the package
group; then click Next. The corresponding national language translations for
the user interface and documentation for the packages are installed. Note that
your choices apply to all packages that are installed under this package group.
4. On the Features page, select the features to install or remove. Some products do
not have optional features.
a. To learn more about a feature, click the feature and review the brief
description under Details.
b. If you want to see the dependency relationships between features, select
Show Dependencies. When you click a feature, any features that depend on
it and any features that are its dependents are shown in the Dependencies
window. As you select or exclude features in the packages, Installation
Manager will automatically enforce any dependencies with other features
and display updated download size and disk space requirements for the
installation.
5. When you are finished selecting features, click Next.
6. On the Summary page, review your choices before modifying the installation
package, and then click Modify.
7. Optional: When the modification process is completed, click View Log File to
see the complete log.

Updating software
You can search for product updates and install the updates for your IBM product.

Before you begin
By default, Internet access is required unless your repository preferences points to
a local update site.
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Each installed package has the location embedded for its default IBM update
repository. For Installation Manager to search the IBM update repository locations
for the installed packages, select the preference Search service repositories during
installation and updates on the Repositories preference page. This preference is
selected by default.
See the Installation Manager help for more information.
Important:
v Close all programs that were installed using Installation Manager before
updating.
v During the update process, Installation Manager might prompt you for the
location of the repository for the base version of the package. If you installed the
product from CDs or other media, they must be available when you use the
update feature.

About this task
To find and install product package updates:

Procedure
1. From the Start page of the Installation Manager, click Update.
2. If IBM Installation Manager is not detected on your computer, continue with
the installation of the latest release. Follow the instructions in the wizard to
complete the installation.
3. In the Update wizard, select the location of the package group where the
product you want to update is installed or select Update All, and then click
Next. Installation Manager searches for updates in its repositories and the
predefined update sites for the product. A progress indicator shows the search
is taking place.
4. If updates for a package are found, then they are displayed in the Updates list
on the Update Packages page after the corresponding package. Only
recommended updates are displayed by default. Click Show all to display all
updates found for the available packages.
a. To learn more about an update, click the update and review its description
under Details.
b. If additional information about the update is available, a More info link is
included at the end of the description text. Click the link to display the
information in a browser. Review this information before installing the
update.
5. Select the updates that you want to install or click Select Recommended to
restore the default selections. Updates that have a dependency relationship are
automatically selected and cleared together.
6. Click Next.
7. On the Licenses page, read the license agreements for the selected updates. On
the left side of the License page, the list of licenses for the updates you select
is displayed
8. Click each item to display the corresponding license agreement text.
a. If you agree to the terms of all the license agreements, click I accept the
terms of the license agreements.
b. Click Next to continue.
9. On the Summary page, review your choices before installing the updates.
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a. If you want to change the choices you made on previous pages, click Back,
and make your changes.
b. When you are satisfied, click Update to download and install the updates.
A progress indicator shows the percentage of the installation completed.
10. Optional: When the update process is completed, a message that confirms the
process is displayed near the top of the page. Click View log file to open the
log file for the current session in a new window. Close the Installation Log
window to continue.
11. Click Finish to close the wizard.
12. Optional: Only the features that you already have installed are updated using
the Update wizard. If the update contains new features that you want to
install, run the Modify wizard, and select the new features to install from the
feature selection panel.

Uninstalling software
Use the IBM Installation Manager to uninstall your product. If no other products
are installed, you can uninstall Installation Manager also.

Uninstalling Rational Asset Analyzer
To uninstall Rational Asset Analyzer, use Installation Manager.

Procedure
1. Start Installation Manager.
2. On the Start page, click Uninstall.
3. On the Uninstall Packages page, from the Installation Packages list, select the
product package to uninstall, and click Next.
4. On the Summary page, review the list of packages that will be uninstalled, and
click Uninstall. The Complete page is displayed after the packages are
removed.
5. Click Finish.

Results
Note: Uninstalling Rational Asset Analyzer does not drop the database.

Uninstalling Installation Manager
Follow these steps to remove IBM Installation Manager from your workstation.

Before you begin
Before you can uninstall IBM Installation Manager, you must uninstall all of the
packages and products that were installed with Installation Manager. Close the
Installation Manager before attempting to uninstall the program.
You must be logged onto your workstation with a user account that has the same
privileges as the one used to install Installation Manager.

About this task
To uninstall Installation Manager, complete the following steps:
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Note: If you receive an error after uninstalling Installation Manager on Solaris,
close the dialog box with the error message and manually delete the following
empty directories: /var/ibm/InstallationManager/uninstall and
/var/ibm/InstallationManager.

Procedure
To uninstall Installation Manager:
1. From the Start menu, click Control Panel > Add or Remove Programs.
2. On the "Change or Remove Programs" page, select IBM Installation Manager
and click Remove.
3. In the Add or Remove Programs window, click Yes to continue with the
removal.

Results
You have removed IBM Installation Manager from your workstation.

Known problems
Many problems can be attributed to an incorrect or incomplete installation or
configuration of prerequisite products. Before installing and using your product,
review the known problems.
Use the following tips to ensure that you have eliminated the cause of common
problems:
v Verify the correct installation and configuration of prerequisite products before
you proceed with installation and configuration of Rational Asset Analyzer.
v Verify proper installation and configuration of the Rational Asset Analyzer
product itself.
Known problems are grouped into the following categories:
v “DB2”
v “Home page problems” on page 28
v “Install problems” on page 29
v “Licensing problems” on page 30
v “Inventory problems” on page 31
v “Scanning problems” on page 31

DB2
DB2 errors occur when accessing data in the Rational Asset
Analyzer interface
When you access data in the Rational Asset Analyzer interface, DB2 might fail. To
avoid this problem, make sure that the latest DB2 fix packs are installed.
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Home page problems
Error occurs when opening the Rational Asset Analyzer Home
page
When navigating to the Rational Asset Analyzer Home page, you might receive the
following messages:
DMH5252E
The jdbc/DMHDB data source could not be located. Make sure that the
name has been defined to WebSphere Application Server.
DMH7883E
The appropriate method to access the database could not be found
To determine more about the problem, do the following tasks:
1. Check that a DB2 connection can be established outside of Rational Asset
Analyzer. Use the DB2 command window to connect to DB2. Use the user ID
and password specified during installation. For example, run the following
commands.
db2cmd
db2connect to DMHDB user myuserid password mypassword
db2connect reset

2. Check the SystemErr.log and the SystemOut.log log files for more details.
These log files can be found in the \AppServer\logs\<serverName> directory.
3.

Check the Admin Console to see if there is a DataSource defined in Resources
> JDBC Providers (filling in cell, node and server info as appropriate).

4. Check that WebSphere Application Server was restarted after installing Rational
Asset Analyzer.
5. Check the installation log for further information. To view the log file, start
IBM Installation Manager and click File > View log file. Ensure that you select
the correct log file from the list if Installation Manager was closed after the
installation completed
If none of the above tasks provide an explanation, or if you find that you do not
have the appropriate Data Source defined to WebSphere Application Server, install
Rational Asset Analyzer again.

The Rational Asset Analyzer Home page does not display
Check that the correct URL is being used to access Rational Asset Analyzer.

Unable to access other pages from the Rational Asset Analyzer
Home page
If you can get to the Home page, but you cannot get to any other page, you likely
are experiencing a communications or connection problem.
When installing the product, if you entered an IP address rather than a host name,
and your system is assigned a dynamic IP address (using DHCP), the IP address
could have since changed and now be invalid. If that is what has happened,
perform the following steps:
1. Edit the installation_directory\config\Common.cfg file and change the old IP
address to a valid host name for the system, or to a static IP address. Save the
file.
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2. Edit the installation_directory\scan\DmhScan.cfg file and change the old IP
address to the same host name or IP address. Save the file.
3. Restart WebSphere Application Server.
4. From a browser, go to the Home page and click on the Sites count. For each
site that has the old IP address in the Scanner daemon URL value, click on the
site name to go to the detail page, choose Actions > Update the site details,
and then update the value with the correct host name or IP address.

The Rational Asset Analyzer Home page opens, but nothing is
displayed
v Verify that a date stamp and a timestamp are displayed on the Home page.
v There is likely a problem with your JDBC communications. Verify the correct
installation and configuration of JDBC, DB2, and WebSphere Application Server.

Install problems
Installation errors occur during the install step
Verify that prerequisites are installed and gather more information to determine the
source of the problem.
v Check that all the required prerequisite software is installed.
v Check that the application server is running. If the configuration uses the
embedded application server, the status can be checked using the command
installation_directory\bin\server.bat status. If not running, the embedded
application server can be started with the command installation_directory\
bin\server.bat start.
Note: When Rational Asset Analyzer is installed using the embedded
application server, there is no corresponding Windows service installed for the
embedded application server. As a result, the embedded application server shuts
down every time a Rational Asset Analyzer user logs out of the operating
system session on the server system. To avoid this, you can use the Task
Scheduler in Windows to start the embedded application server and keep it
running even when no user is logged on to Windows. For more information, see
“Starting the embedded application server using the Task Scheduler” on page
15.
Otherwise, make sure that the WebSphere Application Server is running.
v Check the installation log for additional information. To view the log file, start
IBM Installation Manager and click File > View Log. If the IBM Installation
Manager was closed when the installation process completed, ensure that the
correct log file is selected.

Errors occur when creating the database
Check the installation log for the following message:
Error during "post-install configure" phase:
Error executing installation_directory\SetupDB.bat operation (status=1).
See agent output log for more information:<path to log file>

To view the log file, start IBM Installation Manager and click File > View Log. If
the IBM Installation Manager was closed when the installation process completed,
ensure that the correct log file is selected.
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If the message is found, locate the log file specified in the message found in the
installation log. Check the contents of the log file for the following text:
SQL1013N The database alias name or database name "DMHDB" could not be found.
SQLSTATE=42705 Database "DMHDB" does not already exist.
Creating new database...
SQL1005N The database alias "DMHDB" already exists in either the local database
directory or system database directory.

If you find the above text, then the DMHDB database has been uncataloged from
DB2, but has not been dropped. This could occur, for example, if you installed a
new DB2 but did not clean up your databases first and did nothing to catalog
them after the new install of DB2. You will need to add the DMHDB database back
to DB2, drop it, and then create it again. To add the database back to DB2, do the
following:
1. Open up the DB2 Control Center
2. Expand the database folder.
3. Right-click on the database folder and select Add.
4. Add the DMHDB database (the directions vary depending upon the version of
DB2 you have installed). If you are sure that the database has the correct
schema, you are done. If the database is not needed, right-click on the DMHDB
database and select Drop to drop the database.
5. Run installation_directory\install\SetupDB.bat DMHDB DMH to create the
database.

Installation fails trying to update web applications or Java
resources
The failure might be a result of a problem with communications between the tool
and the WebSphere Application Server. The installation process is designed to start
the WebSphere Application Server automatically, but sometimes the start does not
succeed.
If you are not using the embedded application server, verify that WebSphere
Application Server is started prior to starting the installation process. Start the
WebSphere Application Server and run the installation process again.

Licensing problems
License key is not recognized
If you have downloaded Rational Asset Analyzer Authorized User license keys and
installed them in a Rational License Server prior to 21 June 2011, these licenses
have been returned in the License Key Center on your behalf in favor of a new
named-user license key template. You should replace the nodelocked keys with
named-user keys acquired from the Rational License Key Center and clean out the
nodelocked entries in your license servers.
See the following technote for details for installing the new license and removing
the old type license from the license server: http://www.ibm.com/support/
docview.wss?uid=swg21503967.
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Inventory problems
The Collect inventory menu is missing in the Rational Asset
Analyzer interface
Check that the user ID being used to access the interface has administrator
authority. Identification is made through the administrators property located in the
installation_directory/config/Common.cfg file. Specify each user ID that should
have administrator privileges. Use an asterisk (*) to specify that all users are
administrators. After updating the property, the application must be restarted. If
you are using the embedded application server, run the command
installation_directory\bin\server.bat restart. Otherwise, restart the enterprise
applications using the WebSphere Application Server administrative console.

Scanning problems
No Container or File assets are created, when scanning the
installation_directory\sample\source library
If after running the scan on the installation_directory\sample\source library,
you do not see the appropriate results, edit the dmh6000.log and dmh6000_1.log
files to find any errors. These files are found in the log directory specified during
installation and identified by the logDir property in the installation_directory\
config\Common.cfg file.
If there are errors, attempt to correct any problems. If you find errors that you do
not understand or cannot correct, consult the Rational Asset Analyzer support page
at http://www.ibm.com/support/entry/portal/Overview/Software/Rational/
Rational_Asset_Analyzer.

A C++ error indicating an abnormal program termination occurs
during scanning of distributed assets
This error occurs when the Java virtual machine attempts to allocate more than the
page size. Check that the Windows virtual memory page size is set to a value
greater than 500 MB. See the online help for more details.

After scanning a COBOL or PL/I source file, the file has an
Analysis status of Completed with the following analysis
message: RC=1 TYPE=COBOL DMH1921E: Source analyzer failed,no
data collected from file:file_name
Open the installation_directory/config/Common.cfg file and in the
[ScanningInfo] section, check the cobolLibrary and pliLibrary properties. A value
of enabled indicates that the particular compiler is set up for use by Rational Asset
Analyzer.
If the value is blank, the particular compiler is not available. If the property is set
to enabled, then the environment must have been set up so that the compiler can
be located during postprocessing.
Next, look at the DMH6000_1.log file found in the directory specify by the logDir
property in Common.cfg. See if it contains any statement like the following:
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\'cob2.exe' is not recognized as an internal or external command,
operable program or batch file.
DMH1929W: COBOL analyzer return code: 1
DMH1921E: Source analyzer failed, no data collected from file: file_name

This indicates that the postprocessor attempted to invoke the COBOL compiler
(cob2.exe), but the compiler wasn't available. If the compiler really is not available
on the server, then the compiler-based scanning support needs to be disabled, and
you need to scan your files again using the proprietary scanner.
1. Disable the compiler-based scanning by doing the following:
a. Edit installation_directory/config/Common.cfg.
b. In the [ScanningInfo] section, set cobolLibrary and pliLibrary to blank
values.
c. If you are using the embedded application server, run the command
installation_directory\bin\server.bat restart. Otherwise, restart the
enterprise applications using the WebSphere Application Server
administrative console.
2. Choose the proprietary scanner for files, container, applications, and sites by
doing the following:
a.

Using the browser, go to Database > COBOL and PL/I scanning options.

b. On the Files tab, search for any files that have scanning options set.
c. Select every asset that says it is configured to use the compiler.
d. Click Configure scanning options.
e. Choose an option other than the compiler-based scanner, and complete the
wizard.
Regardless of which action you take, it is necessary to queue the affected files
again and reanalyze them by doing the following:
1. Queue affected files again.
a. Using the browser, go to Database > COBOL and PL/I scanning options.
b. Click Files with errors.
c. Change the Analysis status search criteria to Completed.
d. In the Activity log messages field, type: *DMH1921E*
e. Click Go.
f. Select all the matching files and then click Queue selected to requeue the
files for analysis.
2. Complete the following steps to run the processor:
a. Using the browser, go to Database > Analysis queue .
b. From the Actions dropdown, select Start postprocessor.

IGYDS0210 with SQL1060N message using compiler-based
scanner
A message similar to RC=12 TYPE=COBOL IGYDS0210: PROGRAM1, line:0) SQL1060N
User "SYSTEM" does not have CONNECT privilege. SQLSTATE=08004 might be
encountered when using Enterprise compiler-based scanning to inventory COBOL
assets.
If you encounter a similar message, determine the user id that is configured in
Microsoft Windows as the Log On As user id (the Local System account, or
another account) for the WebSphere Application Server service where the Rational
Asset Analyzer (RAA) application is running. This user id must have privileges to
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access the RAA DB2 database, for example, DMHDB, in order for the COBOL
compiler to work correctly during Enterprise compiler-based scanning. The
database privileges assigned to the Log On As id for the WebSphere Application
Server service must be the same privileges as assigned to RAA users and
administrators.

Connection problems
Connectionwaittimeoutexception
This exception occurs when the JDBC connection pool reaches the maximum
number of database connections that are allowed, and subsequent database
connection requests cannot be serviced. Check the system log for the following
messages:
v J2CA0045E: Connection not available while invoking method
createOrWaitForConnection for resource jdbc/your_data_source
v DSRA9400E: Fatal error occurred during Connection reassociation:
com.ibm.websphere.ce.j2c.ConnectionWaitTimeoutException: Connection not
available, Timed out waiting for ######
If you encounter these messages, increase the maximum number of concurrent
database connections by using one of the following approaches:
v If you are using the embedded application server, which is implemented by
using the WebSphere Application Server Liberty Profile, open the
installation_directory/config/Common.cfg file and edit the
maxConcurrentPageRequests value. For more information, refer to
“Requirements for the embedded application server” on page 4.
v If you are using WebSphere Application Server Full Profile, use the WebSphere
Application Server Administrative Console. Select Resources > JDBC > Data
Sources > your_data_source > Connection pools, and update the Maximum
connections property.
For more information about configuration and tuning, refer to the WebSphere
Application Server IBM Knowledge Center (http://www.ibm.com/support/
knowledgecenter/SSAW57/mapfiles/product_welcome_wasnd.html).

Planning, installing, and configuring z/OS scanning
Planning, installing, and configuring z/OS scanning.

Planning to install z/OS scanning
Rational Asset Analyzer remote z/OS scanning capability makes it possible to
perform remote scans of assembler source as well as DB2, CICS, and IMS
subsystems on a z/OS system. The z/OS scanning function allows a system
administrator to configure a Rational Asset Analyzer system to scan assets on
z/OS. The scan results can then be imported into Rational Asset Analyzer to give a
more complete view of assets.

About this task
Before you install z/OS Scanning for Rational Asset Analyzer, the following must
be available:
z/OS system settings
v High-level qualifier for temporary installation data sets
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v VOLSER where temporary installation data sets will reside (approximately 230
tracks)
v High-level qualifier for target product data sets
v VOLSER for target product sets (approximately 260 tracks)
v USS directory names for target product files and configuration files
v Hostname of the z/OS system to which installation files will be transferred
using FTP
v User ID and password to use with file transfer
z/OS system authority needed
1. Transfer files using FTP to the z/OS system, creating data sets with high-level
qualifiers of the temporary and target data sets on the specified volumes
2. Transfer files using FTP to the z/OS system, creating USS directories and files
in the specified USS directory
3. Submit a batch job that performs TSO RECEIVE for target data sets
4. Run BPXBATCH in a batch job to extract the files from a TAR file
5. Configure the HTTP server
6. Restart the HTTP server
7. Create USS directories and files
Windows authority
1. Use FTP to transfer the files to z/OS.
2. Update the Rational Asset Analyzer installation directory\config\
Common.cfg file.
3. Restart the application server.

Installing z/OS scanning
During the installation of z/OS scanning, binary sequential data sets are
transferred to the z/OS system and then expanded to the target data sets.

About this task
1. “Specifying configuration parameters”
2. “Transfer the installation files to the z/OS server” on page 35
3. “Receiving the host files” on page 36

Specifying configuration parameters
Before you can transfer the necessary files to the z/OS system, the z/OS
config.bat configuration files must be updated with values specific to your
environment.
The config.bat file contains information that is used during the installation
process.
Edit the config.bat file which is located in installation directory\install\
zosscan directory and provide values for the following configuration parameters
that are specific to your environment.
Host
Host name or IP address of the target z/OS system.
HLQ
High level qualifier of all the expanded target data sets on z/OS.
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VOL
Volume where the expanded target data sets should be created.
BINHLQ
High level qualifier of the temporary binary (*.BIN) sequential data sets on
z/OS.
BINVOL
Volume where the temporary binary (*.BIN) sequential data sets are created.
DMH_HOME
USS directory that will be the root of the USS files.
LANG
Language being used such as, en=English, ja=Japanese, ko=Korean.
Note: The BINHLQ and BINVOL values are used for temporary data sets that can
be cleaned up after the installation is completed. If you want to use the same
volume for both the permanent data sets and temporary ones, set the VOL and
BINVOL settings to the same value.
For example:
SET
SET
SET
SET
SET
SET
SET

HOST=dev.abccorp.com
HLQ=DMH.ZOSSCAN
VOL=WSAA01
BINHLQ=DMH.ZOSSCAN.TEMP
BINVOL=WSAA01
DMH_HOME=/usr/lpp/dmh/zosscan
LANG=en

Transfer the installation files to the z/OS server
After the install\zosscan\config.bat file has been customized for your system,
the installation files can be transferred to the z/OS server.

About this task
Before transferring the files, verify the command files.

Procedure
1. Open a command prompt window and switch to the installation_directory\
install\zosscan directory to verify the command files.
It should contain at least the following:
11/07/2011
11/07/2011
11/08/2011
11/07/2011
11/07/2011

12:39
12:39
04:17
12:39
05:15

PM
PM
PM
PM
AM

<DIR>
<DIR>
1,501 config.bat
<DIR>
files
8,955 upload.bat

2. Transfer the files to z/OS by issuing the upload.bat command and specifying a
user ID and password authorized to transfer the files.
> upload MYUSERID MYPASSWORD
Preparing to FTP installation files to dev.abccorp.com
Temp data sets=DMH.ZOSSCAN.TEMP on WSAA01
Target data sets=DMH.ZOSSCAN on WSAA01
Target HFS files=/usr/lpp/dmh/zosscan
Press any key to continue . . .

The following messages appear while the files are transferred to the z/OS
server.
Uploading installation files...
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3. After the transfer completes, a log file is created in the directory. The
upload.log file indicates that, in addition to the installation files, RECEIVE and
CLEANUP jobs were transferred to the z/OS server. The log file also contains
the requests and responses for the various files sent. Browse the upload.log file
to ensure that there are no unexpected errors. If the DMH_HOME directory
specified in the installation_directory\install\zosscan\config.bat file
already exists, you will see the following error which can be ignored:
ftp> mkdir "/usr/lpp/dmh/zosscan"
550 MKDIR failed: EDC5117I File exists. (errno2=0x05520038)

Receiving the host files
After the files have been transferred to the z/OS server, you can use TSO to view
the data sets and USS files. You will need to create the target data sets and USS
files on the z/OS server.

Procedure
1. Log onto TSO and verify that at least the following data sets and HFS files are
listed:
DMH.ZOSSCAN.TEMP.SDMH.CLEANUP.JCL
DMH.ZOSSCAN.TEMP.SDMH.RECEIVE.JCL
DMH.ZOSSCAN.TEMP.SDMHCNTL.BIN
DMH.ZOSSCAN.TEMP.SDMHDATA.BIN
DMH.ZOSSCAN.TEMP.SDMHLOAD.BIN
DMH.ZOSSCAN.TEMP.SDMHMCHS.BIN (Simplified Chinese-only)
DMH.ZOSSCAN.TEMP.SDMHMJPN.BIN (Japanese-only)
DMH.ZOSSCAN.TEMP.SDMHMKOR.BIN (Korean-only)
DMH.ZOSSCAN.TEMP.SDMHMLIB.BIN
DMH.ZOSSCAN.TEMP.SDMHPCHS.BIN (Simplified Chinese-only)
DMH.ZOSSCAN.TEMP.SDMHPJPN.BIN (Japanese-only)
DMH.ZOSSCAN.TEMP.SDMHPKOR.BIN (Korean-only)
DMH.ZOSSCAN.TEMP.SDMHPLIB.BIN
DMH.ZOSSCAN.TEMP.SDMHREXC.BIN (Simplified Chinese-only)
DMH.ZOSSCAN.TEMP.SDMHREXJ.BIN (Japanese-only)
DMH.ZOSSCAN.TEMP.SDMHREXK.BIN (Korean-only)
DMH.ZOSSCAN.TEMP.SDMHREXX.BIN
DMH.ZOSSCAN.TEMP.SDMHSCHS.BIN (Simplified Chinese-only)
DMH.ZOSSCAN.TEMP.SDMHSIMP.BIN
DMH.ZOSSCAN.TEMP.SDMHSJPN.BIN (Japanese-only)
DMH.ZOSSCAN.TEMP.SDMHSKOR.BIN (Korean-only)
DMH.ZOSSCAN.TEMP.SDMHSLIB.BIN
-rwxr-xr-x 1 ADMIN1 DMHGRP 102400 Jul 31 12:27 dmhhfs.tar
-rwxr-xr-x 1 ADMIN1 DMHGRP 243 Jul 31 12:27 dmhuntar.scr

2. Update the JCL for the job that performs a TSO RECEIVE for each of the
SDMH*.BIN data sets and expands the TAR file to create the target data sets
and USS files
a. Edit the SDMH.RECEIVE.JCL data set and update to provide a correct JOB
card, and make any other modifications needed to conform to your local
standards.
b. Submit the SDMH.RECEIVE.JCL job.
c. After the job completes, verify that all steps finished with a RC=0.
3. Verify that the RECEIVE job successfully created the following data sets and
HFS:
DMH.ZOSSCAN.SDMHCNTL
DMH.ZOSSCAN.SDMHDATA
DMH.ZOSSCAN.SDMHLOAD
DMH.ZOSSCAN.SDMHMCHS (Simplified Chinese-only)
DMH.ZOSSCAN.SDMHMJPN (Japanese-only)
DMH.ZOSSCAN.SDMHMKOR (Korean-only)
DMH.ZOSSCAN.SDMHMLIB
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DMH.ZOSSCAN.SDMHPCHS
DMH.ZOSSCAN.SDMHPJPN
DMH.ZOSSCAN.SDMHPKOR
DMH.ZOSSCAN.SDMHPLIB
DMH.ZOSSCAN.SDMHREXC
DMH.ZOSSCAN.SDMHREXJ
DMH.ZOSSCAN.SDMHREXK
DMH.ZOSSCAN.SDMHREXX
DMH.ZOSSCAN.SDMHSCHS
DMH.ZOSSCAN.SDMHSIMP
DMH.ZOSSCAN.SDMHSJPN
DMH.ZOSSCAN.SDMHSKOR
DMH.ZOSSCAN.SDMHSLIB

(Simplified Chinese-only)
(Japanese-only)
(Korean-only)
(Simplified Chinese-only)
(Japanese-only)
(Korean-only)
(Simplified Chinese-only)
(Japanese-only)
(Korean-only)

Configuring z/OS scanning
After the data sets and files have been installed, both the z/OS system and
Windows server must be configured to use the z/OS scanning function.

Configuring the z/OS server
Procedure
1. Run the DMHMINI command. The DMHMINI command is used to configure various
settings needed by the z/OS scan function.
a. From TSO, issue the DMHMINI command. The format of the command is
different depending on the language on the config.bat configuration file.
v For English use, exec 'DMH.ZOSSCAN.SDMHREXX(DMHMINI)'
v For Japanese, use, exec DMH.ZOSSCAN.SDMHREXJ(DMHMINI)
v For Korean use, exec DMH.ZOSSCAN.SDMHREXK(DMHMINI)
b. Complete the fields of the panel and press PF3 to save your changes. When
PF3 is pressed, your entries are validated and then the CONFIG data sets
and IMPORT data sets are created. In addition, the HFS configuration
directory is created and updated with the latest configuration files.
Table 3. Configuration files
Field name

Configuration file name

High-level qualifier of user DSN

DMH.ZOSSCAN.USER

HFS base directory

/usr/lpp/dmh/zosscan

HFS configuration directory

/etc/zosscan

HFS temporary directory

/var/zosscan

LE runtime library

CEE.SCEERUN

HLASM library

ASM.SASMMOD1

c. After saving your changes, a message displays indicating that the server
must be restarted for the changes you made to take affect. You can wait to
do the restart until after you have performed the Windows server
configuration updates in a following step.
Verify that you now have the following additional data sets:
DMH.ZOSSCAN.CONFIG.CNTL
DMH.ZOSSCAN.CONFIG.DATA
DMH.ZOSSCAN.CONFIG.DMHMSGEC
DMH.ZOSSCAN.CONFIG.LOAD
DMH.ZOSSCAN.CONFIG.REXX
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DMH.ZOSSCAN.USER.ASM.IMPORT
DMH.ZOSSCAN.USER.CICS.IMPORT
DMH.ZOSSCAN.USER.DB2.IMPORT
DMH.ZOSSCAN.USER.IMS.IMPORT

Note: Rational Asset Analyzer installers and administrators require
post-installation authority to update, and possibly re-create, the
&hlq.CONFIG.** data sets. For example, on the following occasions the
installers and administrators need the authority:
v The setup options for DMHMINI or DMHINSTL would be saved upon
exiting after an option value change or to refresh Common.cfg and
DMHPARMS.
v A &hlq.CONFIG.** data set was unexpectedly deleted and must be
reinstated.
2. All z/OS source scanning performed by Rational Asset Analyzer is processed
as batch jobs created through the browser and submitted by the HTTP server.
The default job card that is provided to the browser resides in the
yourHLQ.CONFIG.REXX(DMHPARMS) file. To configure the default JOB card for
clients, complete the following steps.
a. Exit from the DMHMINI install program.
b. Edit DMHPARMS to change the values. Notice that DMHJBDF1 does not
have the full syntax of a job card, just the text that follows the JOB
keyword. Thus, for example, for the following full syntax:
//FOO1 JOB ,MSGLEVEL=(1,1),CLASS=K,

use the following for DMHJBDF1:
DMHJBDF1 = ",MSGLEVEL=(1,1),CLASS=K,"

The job name and JOB keyword are implied.
c. Save your changes.
d. Run the DMHMINI command again. Press F3 to save and exit. This causes
your job card changes to be written to the proper configuration files.
Note that whenever you change configuration options using the DMHMINI
command, you must restart the application server on Windows.
If you find that DMHPARMS does not exist, you have done the configuration
steps out of order. The DMHMINI command must first be performed.
3. IBM HTTP Server is a prerequisite product and must be installed and
configured on your system. Before proceeding, ensure that HTTP Server is
working properly and that it works properly with the other required products.
Before you can use the z/OS scanners, you must make additional configuration
changes to IBM HTTP Server so that it can run the z/OS scanner CGI.
Either the Apache-based IBM HTTP Server V8.5 or the Domino-based IBM
HTTP Server V5R3 can be configured for use with Rational Asset Analyzer. If
you want to use the IBM HTTP Server V8.5 and do not already have it, you
can find ordering information for the unpriced feature at http://
www.ibm.com/systems/z/os/zos/features/unix/ported/ihs/ihsv85.html.
Note: When configuring the HTTP server, you can use the
/usr/lpp/dmh/zosscan/bin/dmh_httpd.conf file as a guide. It contains samples
of most of the statements you need for both versions of HTTP server. You can
copy portions of this file to your own httpd.conf file.
To configure IBM HTTP Server, follow the steps for your particular version of
HTTP server:
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v “Configuring the Apache-based IBM HTTP Server”
v “Configuring the Domino-based IBM HTTP Server”
Configuring the Apache-based IBM HTTP Server:
Perform these steps to configure the Apache-based IBM HTTP Server V8.5.
Procedure
1. Run the following RACF® commands or their equivalent to support the
SAFRunAs directive that will be used in the httpd.conf file:
RDEFINE FACILITY BPX.SERVER UACC(NONE)
PERMIT BPX.SERVER CLASS(FACILITY) ID(<ihs_user_id>) ACC(READ)
SETROPTS RACLIST(FACILITY) REFRESH

2. Ensure the following statements are in the LoadModule section of the httpd.conf
file:
LoadModule
LoadModule
LoadModule
LoadModule

auth_basic_module modules/mod_auth_basic.so
authz_user_module modules/mod_authz_user.so
authnz_saf_module modules/mod_authnz_saf.so
authz_default_module modules/mod_authz_default.so

3. Add the following statements after the first ScriptAlias comment in the
httpd.conf file:
# ===================================================================== #
# Rational Asset Analyzer CGI location
# ===================================================================== #
ScriptAlias /dmhzosscan-cgi/ "/usr/lpp/dmh/zosscan/bin/"
# ===================================================================== #
# Prompt for userid/password for access to Rational Asset Analyzer
# ===================================================================== #
<Location "/dmhzosscan-cgi/">
AuthName "Rational Asset Analyzer"
AuthType Basic
AuthBasicProvider saf
Require valid-user
SAFRunAs %%CLIENT%%
</Location>
<Directory "/usr/lpp/dmh/zosscan/bin/">
AllowOverride None
Options None
Order allow,deny
Allow from all
</Directory>

4. Determine if your system requires Secure Sockets Layer (SSL). If SSL is
required, customize your HTTP server configuration using the "Securing
applications and their environment" topic in the "IBM HTTP Server for
WebSphere Application Server, Version 8.5" section of the WebSphere
Application Server documentation at: http://www.ibm.com/support/
knowledgecenter/SSEQTJ_8.5.5/com.ibm.websphere.ihs.doc/ihs/
welc6top_securing_ihs_container.html.
5. Restart the HTTP server.
Configuring the Domino-based IBM HTTP Server:
Perform these steps to configure the Domino-based IBM HTTP Server V5R3.
Procedure
1. Edit the server configuration file.
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2. Rational Asset Analyzer requires each user to be uniquely identified. The IBM
HTTP Server UserId and Protection directives can force the user to provide a
valid userid and password. Check that the settings for the UserId directive are
in accordance with the access guidelines for your site. The UserId directive
controls access to the Rational Asset Analyzer CGI on your z/OS system.
Follow one of the following two examples, depending on your site security
guidelines for HTTP server access.
If your site guidelines require each user to log on with his or her own userid,
then use the directive UserId %%CLIENT%%, which tells the server to require that
the requester has a local z/OS userid and password.
EDIT /etc/httpd.conf
# Default: %%CLIENT%%
# Syntax: UserId <user name>
# Example:
# UserId PUBLIC
UserId %%CLIENT%%
# UserId %%CERTIF%%
# UserId %%SERVER%%
# UserId %%CLIENT%%

If your site guidelines specify that all users share access with a single userid,
such as UserId PUBLIC, then you must establish additional protection scheme
directives for the Rational Asset Analyzer application. Add these additional
protection scheme directives to the configuration file preceding any Exec
directives that reference Rational Asset Analyzer web addresses.
# ===================================================================#
# Prompt for userid/password for access to AA
# ===================================================================#
Protection DMH_Prot {
UserId %%CLIENT%%
ServerId "Asset Analyzer"
AuthType Basic
PasswdFile %%SAF%%
Mask All
}
Protect /dmhzosscan-cgi* DMH_Prot

3. Define an Exec directive that associates the web addresses used by Rational
Asset Analyzer with the directory that contains the Rational Asset Analyzer
z/OS scanning CGI scripts. Add the Exec directive to the Mapping Rules
section of the httpd.conf file. For example, if Rational Asset Analyzer z/OS
scanning is installed in /usr/lpp/dmh/zosscan, the httpd.conf file would
contain the following line:
#
Exec /dmhzosscan-cgi/* /usr/lpp/dmh/zosscan/bin/*
#

The path, such as dmhzosscan-cgi, that you specify must be protected by the
protection scheme directives that are shown in step 2.
4. Determine if your system requires Secure Sockets Layer (SSL). If so, use the
IBM Key Management Utility (IKEYMAN) to create, process, and manage the
files that are needed for secure connections.
5. Restart the HTTP server.

Configuring the Windows server
The Windows server configuration must be updated so that it can communicate
with the CGI running under the HTTP server on z/OS. To make that connection,
update the installation directory\config\Common.cfg file.
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Procedure
1. Update the [RemoteRequest] section to reflect your configuration. Make sure
that the webPath value is the same name as that used above when configuring
the HTTP server.
#-----------------------------------------------------------# ---RemoteRequest--# This specifies the attributes used for remote CGI requests.
#-----------------------------------------------------------[RemoteRequest]
protocol = http
hostname = dev.abccorp.com
port = 80
webPath = dmhzosscan-cgi

2. Update the [MVS] section to reflect the high-level qualifier where the target
data sets reside on your z/OS server. This is the same value specified as the
HLQ variable in the config.bat file when files were uploaded to z/OS server.
[MVS]
HLQ = DMH.ZOSSCAN

3. After updating the configuration file, restart the application server. If you are
using the embedded application server, run the command
installation_directory\bin\server restart. Otherwise, restart WebSphere
Application Server.

Securing data sets, directories, and files on z/OS for Rational
Asset Analyzer
About this task
Rational Asset Analyzer z/OS scanning relies on an SAF-compliant security
product for its operating system security interfaces. The configuration for Rational
Asset Analyzer z/OS scanning assumes the use of z/OS Security Server (RACF). If
you use another security product, consult the vendor for more information.
Rational Asset Analyzer has the following user types:
v Admin users
v Non-admin users
v Installer who configures the product
Note: When "all users" is used, it includes all the types of users.

Procedure
1. Review the settings for the various product data sets and directories by
browsing the values provided to the DMHMINI Minimal set up panel.
2. Create RACF groups:
v Define a RACF group, such as DMH1, that protects product resources that all
users require.
v Define a RACF group, such as DMHCFG1, that protects product resources
that the installer needs, in addition to the resources that they get from the
DMH1 RACF group.
3. Protect data sets:
v Ensure that the product data sets can be read.
v Ensure that the product configuration data sets created by the DMHMINI
Minimal set up panel can be updated. Two exceptions are the
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CONFIG.LOAD and CONFIG.REXX data sets. Admin and non-admin users
should have only read access to the data sets. However, the installer needs to
be able to create and delete them.
v Ensure that the high-level qualifier for user data sets is protected in such a
way that all users (including those whose ID is used by the loading and
postprocessing jobs) can create and delete temporary data sets.
4. Add users to RACF groups:
v Add all Rational Asset Analyzer users to the DMH1 RACF group.
v For any installer who configures the product by running the DMHMINI
Minimal set up panel, add their ID to the DMHCFG1 RACF group in
addition to the DMH1 RACF group.
5. Ensure that list-of-groups (GRPLIST) checking is enabled. For more information
about GRPLIST support, see z/OS Security Server RACF Security Administrators
Guide.
6. Protect USS directories and files:
v Ensure that the product USS directories and files can be read by all users.
v Ensure that the product configuration USS directories and files created by the
DMHMINI Minimal set up panel can be read by all users, but can be created
and updated by the installer.
v Ensure that all users can create and delete files in the USS directory for
temporary files.
Note: If the Rational Asset Analyzer data sets or directories are ever deleted
and re-created, the steps to secure data sets, directories, and files must be
repeated.

Example
Table 4. Settings used in the following examples

42

Installation Guide

Description

Value

High-level qualifier where the product is
installed

DMH610.SYS1

High-level qualifier for configuration data
sets. This is relative to the high-level
qualifier where the product is installed. It's
always <hlq>.CONFIG

DMH610.SYS1.CONFIG

“High-level qualifier of user DSN” specified
in the DMHMINI Minimal set up panel

DMH610.SYS1.USR

USS directory where the product is installed

/usr/lpp/dmh610sys1

“HFS configuration directory” specified in
the DMHMINI Minimal set up panel

/etc/dmh610sys1

“HFS temporary directory” specified in the
DMHMINI Minimal set up panel

/var/dmh610sys1

RACF group being used to protect product
data sets, directories, and files so that they
can be used by all users. It must have an
OMVS segment.

DMH1

RACF group being used to protect product
data sets that are used by the installer

DMHCFG1

Admin or non-admin Rational Asset
Analyzer user

USER1

Table 4. Settings used in the following examples (continued)
Description

Value

ID of the installer who is configuring
Rational Asset Analyzer

INSTUSR

Table 5. Example data sets, directories, and files
Description

Example data sets, directories, and files

Protection

Product data sets
from SMP/E
installation, and then
copied to
DMH610.SYS1.**

DMH610.SYS1.SDMHCNTL
DMH610.SYS1.SDMHDATA
DMH610.SYS1.SDMHDBRM
DMH610.SYS1.SDMHLOAD
DMH610.SYS1.SDMHMLIB
DMH610.SYS1.SDMHPLIB
DMH610.SYS1.SDMHREXX
DMH610.SYS1.SDMHSIMP
DMH610.SYS1.SDMHSLIB
DMH610.SYS1.SDMHSSRC
Chinese only:
DMH610.SYS1.SDMHMCHS
DMH610.SYS1.SDMHPCHS
DMH610.SYS1.SDMHSCHS
Japanese only:
DMH610.SYS1.SDMHMJPN
DMH610.SYS1.SDMHPJPN
DMH610.SYS1.SDMHSJPN

All users need READ
access.

Product USS
/usr/lpp/dmh610sys1/bin
directories and files
/usr/lpp/dmh610sys1/config
from SMP/E
/usr/lpp/dmh610sys1/lib
installation, and then
copied to
/usr/lpp/dmh610sys1

All users need READ
access.

Product
configuration data
sets. Their names are
always relative to the
product data sets.
They are created by
the DMHMINI
Minimal set up
panel.

All users need
UPDATE access to
the CNTL, DATA,
and DMHMSGEC
data sets, and READ
access to the LOAD
and REXX data sets.

DMH610.SYS1.CONFIG.CNTL
DMH610.SYS1.CONFIG.DATA
DMH610.SYS1.CONFIG.DMHMSGEC
DMH610.SYS1.CONFIG.LOAD
DMH610.SYS1.CONFIG.REXX

The installer needs
ALTER for all the
product
configuration data
sets.
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Table 5. Example data sets, directories, and files (continued)
Description

Example data sets, directories, and files

Protection

User data sets.
They’re qualified by
the “High-level
qualifier of user
DSN” setting in the
DMHINSTL Set up
option. The initial set
of data sets listed
here is created by
that option. When
users perform
various actions in the
product, other user
data sets are created,
used, and deleted.

DMH610.SYS1.USR.ASM.IMPORT
DMH610.SYS1.USR.CICS.IMPORT
DMH610.SYS1.USR.DB2.IMPORT
DMH610.SYS1.USR.IMS.IMPORT

In general, all users
need ALTER access
to user data sets.
However, they only
need UPDATE access
for the data set that
listed here.

HFS configuration
directory. This is
specified in and
created by the
DMHMINI Minimal
set up panel.

/etc/dmh610sys1/Common.cfg
/etc/dmh610sys1/SetupJavaHome.sh
/etc/dmh610sys1/dmh.keystore
/etc/dmh610sys1/i18n/Common.properties
Japanese only:
/etc/dmh610sys1/i18n/Common_ja.properties
Chinese only
/etc/dmh610sys1/i18n/Common_zh.properties

All these directories
and files need group
permission bits of
750 so that all group
members can READ
and EXECUTE.

/var/dmh610sys1/log
/var/dmh610sys1/temp
/var/dmh610sys1/work

All these directories
and files need group
permission bits of
770 so that all group
members have full
permissions to create
and delete files.

HFS temporary
directory. This is
specified in and
created by the
DMHMINI Minimal
set up panel.

The installer needs
ALTER for all the
user data sets.

The installer needs
all permissions on
the directories and
files.

The installer needs
all permissions on
the directories and
files.

Example RACF commands run from TSO
ADDGROUP DMH610
ADDGROUP DMH1
SUPGROUP(DMH610) OMVS(GID(nnnnnn))
ADDGROUP DMHCFG1 SUPGROUP(DMH610)
ADDSD ’DMH610.SYS1.*’
UACC(NONE) OWNER(DMH1)
ADDSD ’DMH610.SYS1.CONFIG.*’
UACC(NONE) OWNER(DMH1)
ADDSD ’DMH610.SYS1.CONFIG.LOAD’ UACC(NONE) OWNER(DMH1)
ADDSD ’DMH610.SYS1.CONFIG.REXX’ UACC(NONE) OWNER(DMH1)
ADDSD ’DMH610.SYS1.USR.*’
UACC(NONE) OWNER(DMH1)
PERMIT ’DMH610.SYS1.*’
ACCESS(READ) ID(DMH1)
PERMIT ’DMH610.SYS1.CONFIG.*’
ACCESS(UPDATE) ID(DMH1)
PERMIT ’DMH610.SYS1.CONFIG.LOAD’ ACCESS(READ) ID(DMH1)
PERMIT ’DMH610.SYS1.CONFIG.REXX’ ACCESS(READ) ID(DMH1)
PERMIT ’DMH610.SYS1.USR.*’
ACCESS(ALTER) ID(DMH1)
PERMIT
PERMIT
PERMIT
PERMIT
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’DMH610.SYS1.*'
’DMH610.SYS1.CONFIG.*’
’DMH610.SYS1.CONFIG.LOAD’
’DMH610.SYS1.CONFIG.REXX’

ACCESS(ALTER)
ACCESS(ALTER)
ACCESS(ALTER)
ACCESS(ALTER)

ID(DMHCFG1)
ID(DMHCFG1)
ID(DMHCFG1)
ID(DMHCFG1)

CONNECT USER1 GROUP(DMH1) AUTHORITY(USE)
CONNECT WSSRU1 GROUP(DMH1) AUTHORITY(USE)
CONNECT INSTUSR GROUP(DMH1 DMHCFG1) AUTHORITY(USE)
SETROPTS GENERIC(DATASET) REFRESH
SETROPTS GRPLIST

Note: If a user is added to a RACF group as a result of a CONNECT command
while the user is logged on, the user must log off and log on again to use that
authority to access resources in classes that were RACLISTed.
The following example commands can be used before or after you run the
DMHMINI Minimal set up panel. When the commands are used before you run
the DMHMINI Minimal set up panel, the configuration and temporary directories
do not yet exist and can be created with the mkdir commands shown in the
example below. When the commands are used after running the DMHMINI
Minimal set up panel, the mkdir commands can be skipped. The remaining chgrp
and chmod commands can be used when the directories are initially created, or
after you run the DMHMINI Minimal set up panel.
Example USS configuration commands run from OMVS
mkdir
mkdir
mkdir
chgrp
chgrp
chgrp
chmod
chmod
chmod

/etc/dmh610sys1
/etc/dmh610sys1/i18n
/var/dmh610sys1
-R DMH1 /usr/lpp/dmh610sys1
-R DMH1 /etc/dmh610sys1
–R DMH1 /var/dmh610sys1
-R 750 /usr/lpp/dmh610sys1
-R 750 /etc/dmh610sys1
-R 770 /var/dmh610sys1

Note: The person who installs or updates (eg. INSTUSR) needs to be the owner of
the /etc/dmh610sys directory and files, or they need to have root authority so that
the DMHMINI Minimal set up panel can create and update files in that directory.
Allowing other users to update the configuration
To allow multiple users access to the DMHMINI Minimal set up panel for
maintaining RAA, complete the following steps:
1.

Ensure that Access Control Lists (ACLs) are enabled in the Unix System
Service environment. With RACF, ACLs are enabled by a RACF administrator
by enabling the FSSEC class, for example: SETROPTS CLASSACT(FSSEC)

2. Update the ACLs for all the configuration directory files so that users in the
DMHCFG1 group have full authority for the configuration files. For example,
the owner of the configuration files or a user with root authority would update
the ACLs using the following code:
setfacl -m g:DMHCFG1:+rwx /etc/dmh610sys/*
setfacl -m g:DMHCFG1:+rwx /etc/dmh610sys/i18n/*

3. Add the users to the DMHCFG1 RACF group.
For more information, see z/OS Security Server RACF Command Language Reference
and z/OS Security Server RACF Security Administrator's Guide in IBM Knowledge
Center.
You can find information about activating list-of-groups checking (GRPLIST
Option) and using RACF with z/OS UNIX in z/OS Security Server RACF Security
Administrator's Guide.
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Verifying the z/OS scanning installation
To ensure that the z/OS and Windows installation and configuration steps were
successful, you should perform the following verification steps.
v “Verifying the CGI, part I”
v “Verifying the CGI, part II” on page 47

Verifying the CGI, part I
To verify that the Common Gateway Interface (CGI) for the product is operating
correctly

Procedure
1. Type the following address in your browser:
http://hostname:cgiport/dmhzosscan-cgi/dmhremotefunctions.rexx?action=
getSettings&hlq=yourHLQ

hostname
Host name of your z/OS system, such as dev.abccorp.com,
cgiport
The port number for the IBM HTTP Server, such as 80 and yourHLQ is the
high-level qualifier for the Rational Asset Analyzer z/OS data sets, such as
DMH.ZOSSCAN.
Take the following action for the response that you receive:
v You are not prompted to supply your TSO userid and password, ensure that
the following conditions are met:
– Your httpd.conf file has the correct UserID and Protection directives as
specified in configuring HTTP server.
– The HTTP server has been restarted.
v An XML representation of the Common.cfg file is returned: no action required;
the CGI is working.
v HTTP 500, Cannot find the server: Verify that the following conditions are
met:
– You correctly typed the address.
– The HTTP server is started.
– You do not have any error messages that reflect a security problem in the
HTTP Server configuration. Such problems can appear in the HTTP Server
log or in the MVS™ console and can usually be addressed by permitting
access to the resource that is reported in the security error message.
v HTTP 404, Page cannot be found: Verify that the following conditions are
met:
– You correctly typed the address, especially the web path portion after the
hostname:cgiport.
– You updated your httpd.conf file with the Rational Asset Analyzer Exec
directive, and the HTTP server was restarted.
2. Type the following address into your browser:
http://hostname:cgiport/dmhzosscan-cgi/dmhremotefunctions.rexx?
action=checkContainer&container=SYS1.MACLIB&hlq=yourHLQ

hostname
Host name of your z/OS system, such as dev.abccorp.com,
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cgiport
The port number for the IBM HTTP Server, such as 80 and yourHLQ is the
high-level qualifier for the Rational Asset Analyzer z/OS data sets, such as
DMH.ZOSSCAN.
Note: Type the address as one line; it is broken here to fit the page width.
Take the following action for the response you receive:
v An XML response that has no errors in the Trace element is returned, and the
Exists element has a value of 1 to indicate the SYS1.MACLIB data set exists:
No action required; the CGI is working.
v An XML response that lists errors in the Trace element is returned: ensure
that your httpd.conf file was updated as specified in configuring HTTP
server.
Note: If the Trace element is collapsed, click it to see the content.

Verifying the CGI, part II
This verification must be performed for the installation if the database was newly
created or has already been migrated. If a database from a prior level of Rational
Asset Analyzer is being used, and has not been migrated, then perform this step
after the database has been migrated.

Procedure
1. Verify the database version is correct. choose the Database > Execute a query
choice from the Rational Asset Analyzer menu and run the following query.
SELECT * FROM ${tschema}.dmh_system_attr WHERE sys_attr_id = 500

The response from the query should contains a value of 552 or greater for
SYS_INT_ATTR
2. Verify the inventory wizard options, to ensure that all the scanning options are
available. From the Rational Asset Analyzer menu, choose the Database >
Collect inventory option. Ensure that the "Collect Inventory" page contains the
following scanning options:
v Assembler Source
v CICS Online Region
v DB2 System
v IMS Subsystem
v Windows File System
If these scanning options are not listed, do the following steps:
v Make sure that your Common.cfg file was updated with the RemoteRequest
and MVS section changes from the Windows configuration section.
v Verify that the database is at the latest level.
v Ensure that the application server was restarted.
3. To ensure the server on Windows is able to communicate with the CGI running
on z/OS, do the following steps:
a. Choose the Assembler Source option.
b. After the page refreshes, specify a valid z/OS user ID and password and
click Next.
c. Verify that the Inventory wizard advances to the Analyze an assembler file
page, and click Cancel to close the wizard.
If an error occurs, the initial wizard page is displayed again with the relevant
message.
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Cleaning up temporary installation data sets and files
After verifying the z/OS scanning installation, clean up temporary data sets and
files by doing the following steps.

Procedure
1. Update the SDMH.CLEANUP.JCL data set to provide a correct JOB card, and
make any other modifications needed to conform to your local standards.
2. Exit the data set so that it is not in-use.
3. Submit the SDMH.CLEANUP.JCL job. When it completes, verify that all steps
finished with RC=0.

Results
The following temporary data sets and files are deleted:
v Temporary SDMH*.BIN data sets
v SDMH.RECEIVE.JCL
v SDMH.CLEANUP.JCL
v TAR file
v Script file

Maintenance considerations for the import file data set
After the z/OS scanning has been installed and configured, and users begin to
scan assets, it is important to periodically perform maintenance on the data sets
containing the import files output from the scanners.

Managing your import file data sets
The DMHMINI command creates the data sets:
DMH.ZOSSCAN.USER.ASM.IMPORT
DMH.ZOSSCAN.USER.CICS.IMPORT
DMH.ZOSSCAN.USER.DB2.IMPORT
DMH.ZOSSCAN.USER.IMS.IMPORT

DMH.ZOSSCAN.USER is the value you specified for the High-level qualifier of
user DSN setting in the DMHMINI.

Compressing data sets
When scanning is performed, new members are added to these data sets and
existing members are replaced. Depending on the number of scans being
performed, you should periodically compress these data sets to avoid any E37
abends.

Reallocating data sets
Likewise, if scans of large amounts of data are performed, it could be necessary to
reallocate these data sets. You can safely reallocate the data sets to increase the
directory or space as long as you maintain the same data set attributes for the
DSORG, RECFM, LRECL, and BLKSIZE.
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Deleting members
There are no actions that delete members from these import data sets. If a member
of the import data set is no longer needed, maybe because it has already been
loaded into the Rational Asset Analyzer database, you can safely delete the
member from the IMPORT data set.

Installing Rational Asset Analyzer Eclipse plug-in for Rational
Developer for System z
For information on using the Rational Asset Analyzer, refer to the topic in the
product help or the Rational Asset Analyzer information center.

Installation prerequisites
The Rational Asset Analyzer Eclipse plug-in for Rational Developer for System z
has the following prerequisites for local scanning:
v Rational Asset Analyzer
v Rational Developer for System z
For an up-to-date list of the minimum required levels of these prerequisites, see:
v System Requirements for Rational Asset Analyzer
v System Requirements for Rational Asset Analyzer for System z
If you plan to search remote instances of Rational Asset Analyzer on z/OS, the
remote instances must be at the latest available service level.
After the prerequisites have been installed on your workstation, proceed with the
installation process.

Installing Rational Asset Analyzer Eclipse plug-in for Rational
Developer for System z
Before you begin
Rational Developer for System z must be closed in order to perform this
installation. Installation Manager will prompt you to exit Rational Developer for
System z if it is running when you initiate this installation.

Procedure
1. If the Rational Asset Analyzer product DVD is not already in your Windows
system, insert the DVD. The Rational Asset Analyzer launchpad opens
automatically if autorun is enabled on your system. If autorun is not enabled,
you need to start launchpad.exe in the installer directory to start the
launchpad.
2. Click the Install Rational Asset Analyzer link. The Install Packages page opens
3. Ensure IBM Rational Asset Analyzer Plug-in for IBM Rational Developer for
System z 6.0 is checked, and click Next
4. Scroll through and read the license agreement. When you have completed
reading the agreement, select the I accept the terms in the license agreement
radio button, and click Next.
5. In the Location panel, select the package group that contains IBM Rational
Developer for System z. Click Next.
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6. On the Features panel, Rational Asset Analyzer Plug-in for IBM Rational
Developer for System z 6.1 is preselected as the feature to install. The lower
half of the panel provides details and disk space information. Click Next to
continue.
7. Check the options and values listed on the Summary page. If you need to make
any changes, click Back to return to previous pages. Otherwise, click Install to
finish the installation.
8. When the installation completes, click Finish. If any installation errors occur,
click the View log file link for more information.

Verifying the installation
To verify that the Rational Asset Analyzer Eclipse plug-in for Rational Developer
for System z has been successfully installed, go to Window -> Preferences, and
ensure that Asset Analyzer is present.
If you want to be able to scan files in your local workspace, select the Enable
Local Scanning option in the Asset Analyzer preferences page, specify the location
where Rational Asset Analyzer is installed on your local system, and then click
Apply. If successful, the Connection status is Connected. If the status is not
Connected, refer to Troubleshooting in the online help.
If you only plan on using the Rational Asset Analyzer Eclipse plug-in for Rational
Developer for System z to search remote instances of Rational Asset Analyzer, you
can disable the Enable Local Scanning option.
(Optional) In the section Remote RAA Servers, specify the location of any remote
instances of Rational Asset Analyzer running on z/OS that you would like to be
able to perform searches against in the Eclipse user interface.

Results
The specified hosts should have Remote System Explorer daemons running on
them and registered in the Remote Systems view in Rational Developer for System
z. The Remote System Explorer is used to retrieve remote source code. If you do
not have an Remote System Explorer daemon set up on the z/OS machine, you
will be able to access most functionality in the Rational Asset Analyzer Eclipse
plug-in for Rational Developer for System z, but you will not be able to view the
source code of assets in the remote Rational Asset Analyzer repository. It is also
important that the same host name is used for both the Rational Asset Analyzer
server name and the RSE host name.

The connection status should read Connected if the Rational Asset Analyzer
Eclipse plug-in for Rational Developer for System z was able to successfully access
the remote instance of Rational Asset Analyzer. If the connection status shows any
warnings or errors, see “Known problems” on page 27 for possible solutions.
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Appendix. Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.
This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM web sites are provided for
convenience only and do not in any manner serve as an endorsement of those web
sites. The materials at those web sites are not part of the materials for this IBM
product and use of those web sites is at your own risk.

© Copyright IBM Corp. 2013, 2018

51

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
Intellectual Property Dept. for Rational Software
IBM Corporation
5 Technology Park Drive
Westford, MA 01886
U.S.A.
Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.
The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.
Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.
All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.
This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Trademark acknowledgments
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at www.ibm.com/legal/
copytrade.shtml.
Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.
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Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.
Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.
UNIX is a registered trademark of The Open Group in the United States and other
countries.
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